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Introduction
The purpose of  the QuantumCVManager application is to make it easy to program your Quantum locomotive’s
Configuration Variables. Both Service Mode Programming and Operations Mode Programming are supported.

You can also use QuantumCVManager to run your Quantum locomotives in Operations Mode. Test Cab popup
windows are provided for this purpose. However, these Test Cabs are for testing purposes only, operating a limited
number of locomotives to get immediate feedback on the effects of CV changes. Running many locomotives on a large
layout  is beyond the scope of QuantumCVManager.

QuantumCVManager supports multiple open documents. The number of documents that can be open at the same time
is limited only by your PC system resources.

QuantumCVManager currently only works with a limited number of DCC Controllers: the Quantum Programmer and
the NCE Powerhouse. Support for additional DCC Controllers may be added at a future date.

QuantumCVManager is geared towards QSI equipped decoders. It provides only basic support for non QSI equipped
decoders. It gives good support for most standard NMRA CV’s, but it gives only generic support for other
manufacturer’s unique CV’s.

QuantumCVManager is designed to be used with locomotives containing version 7 firmware. With locomotives
containing version 6 or earlier firmware, you can use it nearly seamlessly for standard NMRA CV’s. You can also use it
for QSI’s unique CV’s, but there are limitations, including:

• There are additional CV51 CV’s in version 7.
• There are additional CV52 Individual Volumes in version 7.
• Version 7 supports CV55 Feature Configuration and version 6 does not.
• Many of the CV53 Feature ID’s, especially those for lights, are different for version 7.
• There are additional CV56 CV’s in version 7.

Consult the version 3.0 DCC Reference Manual for information about the CV’s that are supported by version 6 and
earlier firmware. This manual is available at http://qsisolutions.com/pdf/q-dccman30.pdf

Consult the version 4.0.2 DCC Reference Manual for information about the CV’s that are supported by version 7
firmware. This manual is available at http://qsisolutions.com/pdf/q_dcc_man_402.pdf
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Installing QuantumCVManager
Get the install file for the latest version of QuantumCVManager from the QSI Solutions website at:
http://www.qsisolutions.com/products/q-programmer.html

Double click on the install file name.

The install screen will appear.

Click  
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Click and then click 

Click  
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Click  

Click 

QuantumCVManager  is now installed.
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Starting QuantumCVManager
You can start QuantumCVManager by double clicking the QuantumCVManager shortcut on the desktop. In this case,
QuantumCVManager’s document window space is initially empty. You must create a new document  using the “File |
New…” command or open an existing QCV file using the “File | Open…” command.

You can also start QuantumCVManager by dragging a QCV file name onto the QuantumCVManager desktop shortcut.
(Note: the desktop shortcut created by the InstallShield Wizard may not allow you to do this. You may have to create
your own desktop shortcut by clicking the right mouse button on the QuantumCVManager.exe file name and selecting
“Create Shortcut”.)

You can also start QuantumCVManager by double clicking on a QCV file name. The QCV file is opened and displayed
in a document window.

Because QuantumCVManager acquires the connection to the Command Station, only one instance of
QuantumCVManager can run at a time.

McAfee Warning:

If you have MacAfee software installed, this warning may be displayed the first time you run QuantumCVManager.

If this message appears, click  and 

Then click 

You will only have to do this once.
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QuantumCVManager Window
This is what the QuantumCVManager window looks like when a document is open.

At the top of the window is the menu bar 1.

Below the menu bar is the control bar 2.

Beneath the control bar is the document window 3.

At the bottom is the status bar 4.
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Menu Bar

File Menu
New… Create a new document.
Open… Open an existing document.
Close Close the active document.
Save Save the active document.
Save As… Save the active document with a new name.

Reload Reload the disk copy of the active document, discarding all changes made since the
last save.

Print… Print the active document.
Print Preview Preview the printed document.
Print Setup… Change the printer and printer options.
Page Setup… Specify the printed page layout.

Exit End the QuantumCVManager session.

Edit Menu
Reset to Defaults… Reset the active document’s contents to factory defaults.
Mark Decoder Value
Unknown

Mark “Decoder Value Unknown” for the active CV, all CV’s in the active page, or all
CV’s in the document.

View Menu
Show [Hide] Test Cab Show or hide the Test Cab attached to the active document.
Show [Hide] Test Cab #1 Show or hide the Test Cab #1.
Show [Hide] Test Cab #2 Show or hide the Test Cab #2.
Show [Hide] Test Cab #3 Show or hide the Test Cab #3.
Show [Hide] Test Cab #4 Show or hide the Test Cab #4.
Show [Hide] Control Bar Show or hide the control bar.
Show [Hide] Status Bar Show or hide the status bar.

Command Station Menu
Operations Mode Select Operations Mode.
Service Mode Select Service Mode.

Enable Main Track In Operations Mode, turn on track power.
Disable Main Track In Operations Mode, turn off track power.

Select Command Station Select between NCE Powerhouse and Quantum Programmer.
Command Station Options… Select Comm Port and Baud Rate for NCE Powerhouse. Select USB driver to be

used with Quantum Programmer.
Diagnostics… Quantum Decoder Diagnostic Tests
About Quantum
Programmer…

Display Quantum Programmer firmware version number and copyright.
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Decoder Menu
<name of active CV> Select CV range to be active CV.
<name of active page> Select CV range to be active page.
Selected Pages Select CV range from list of pages.
All CV’s Select CV range to be all CV’s.

Program Program CV’s in range.
Read Out Operations Mode: Read out value of active CV.
Retrieve Service Mode: Retrieve all CV’s range.
Verify Service Mode: verify all CV’s in range.

Decoder Address… Specify the working Decoder Address.

Program Any CV… Explicitly access any CV.
Reset Decoder to Defaults… Reset QSI equipped locomotive to factory defaults.
About Decoder… Retrieve, or have read out, the decoder model number, firmware version number,

and firmware build date.

Select a CV range with first four items. Act upon this range with the next three items.

Options Menu
Auto Program On Enable Auto Programming.
Auto Program Off Disable Auto Programming.

Enable All CV’s In Operations Mode, turn on track power.
Enable Only Support CV’s In Operations Mode, turn off track power.

Read Out CV Number = Value In Operations Mode, read out CV number, Primary Index, and Secondary Index as
well as CV value.

Read Out Value Only In Operations Mode, read out CV value only.

If  “Auto Program On” is selected, when you change a CV in the document, the CV is automatically programmed in the
locomotive.

If “Enable All CV’s “is selected, all possible CV’s are available for programming, regardless of whether or not a CV is
supported in the locomotive.

If “Read Out CV Number = Value” is selected, the CV number, Primary Index, and Secondary Index are read out as
well as the CV value. For example, if CV55.70.1 had a value of “2”, the locomotive would announce “C V 5 5 point 7 0
point 1 equals 2”. If “Read Out Value Only” were selected, the locomotive would announce “2”.

Window Menu
Cascade Arrange windows so they overlap.
Tile Horizontally Arrange windows as non-overlapping tiles.
Tile Vertically Arrange windows as non-overlapping tiles.
Arrange Icons Arrange icons at the bottom of the window.
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Help Menu
About QuantumCVManager… Display program information, version number and copyright.
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Control Bar
The Control Bar provides shortcuts for several of the main menu commands.

The “Decoder Address…” button is a shortcut for the Decoder menu “Decoder Address…“ command. The working
decoder address is shown in the box beneath the “Decoder Address…” button.

The “Operations Mode” and “Service Mode” buttons are shortcuts for the first 2 items in the Command Station menu.

The list box in the center of the control bar is a shortcut for the first 4 items in the Decoder menu. The 3 buttons below
the list box are shortcuts for the next 3 items in the Decoder menu.

The “Program Any CV…” and “Reset Decoder…” buttons are shortcuts for the Decoder menu items “Program Any
CV…” and “Reset Decoder to Defaults…”.

The “Auto Program On” and “Auto Program Off” buttons are shortcuts for the first 2 items in the Options menu.

To hide the control bar click on the View menu “Hide Control Bar” command.
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Status Bar
The Status Bar displays useful information about the state of QuantumCVManager.

The left portion is for help messages.

The middle portion displays the model number and descriptive model name associated with the active document.

The right portion displays which Command Station has been selected. In the example shown, the Quantum
Programmer has been selected.

To hide the status bar click on the View menu “Hide Status Bar” command.
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The Document Window
The document window consists of several tabbed pages which organize CV’s into meaningful categories.

Loco Standard NMRA CV’s: the Primary Address (CV1), Extended Address (CV17-18), and
Configuration Data (CV29).

Load Standard NMRA Load CV’s: Acceleration Rate (CV3), Deceleration Rate (CV4), Acceleration
Adjustment (CV23), and Deceleration Adjustment (CV24).

Motor Standard NMRA Motor CV’s: Vstart (CV2), Vhigh (CV5), Vmid (CV6), Total PWM Period
(CV9), EMF Feedback Cutout (CV10), Speed Table Select (CV25), Kick Start (CV65),
Forward Trim (CV66), and Reverse Trim (CV95).

Spd Tbl Standard NMRA speed table CV’s 67-94.
Consist Standard NMRA Consist CV’s: Consist Address (CV19), and Consist Functions (CV21 and

CV22),
Func Map Standard NMRA Function Mapping CV’s 33-46.
Fail-safe Standard NMRA Fail-safe CV’s: Packet Time-Out (CV11), Power Source Conversion

(CV12), Alt Mode Status (CV13 and CV14).
Info Standard NMRA Information CV’s: Mfg Version No. (CV7), Mfg ID (CV8), Error Information

(CV30), User ID (CV105 and CV106).
Snd Ctrl QSI unique CV51.PI CV’s for Sound Control.
Ind Snd Vol QSI unique CV52.PI CV’s for individual sound volumes.
Output Map QSI unique CV53.PI.SI CV’s for Output mappings.
Feature Config QSI unique CV55.PI.SI CV’s. This page itself consists of several tabbed pages, each page

corresponding to one feature or a few associated features.
Bell Bell (CV55.3.SI) configuration.
HL/RL Headlight (CV55.70.SI) and Reverse Light (CV55.73.SI) configuration.
Mars Mars Light (CV55.76.SI) and Rear Mars Light (CV55.80.SI) configuration.
Ditch Ditch Lights (CV55.84.SI) configuration.
Number Board Front Number Board Lights (CV55.100.SI) and Rear Number Board Lights (CV55.102.SI)

configuration.
Marker Front Marker Lights (CV55.104.SI) and Rear Marker Lights (CV55.106.SI) configuration.
Step Front Step Lights (CV55.112.SI) and Rear Step Lights (CV55.114.SI) configuration.
Cab Front Cab Lights (CV55.116.SI) and Rear Cab Lights (CV55.118.SI) configuration.
Multiple Lights Multiple Automatic Lights #1 (CV55.136.SI), Multiple Automatic Lights #2 (CV55.137.SI),

and Multiple Automatic Lights #3 (CV55.138.SI) configuration.
Status Status Report (CV55.178.SI) configuration.

Config QSI unique CV56.PI.SI CV’s.
PID QSI unique CV56.PI.SI CV’s for motor PID parameters.
About Contains information about the QSI equipped locomotive: Decoder Model, Soundset

Number, Firmware Version Number and Firmware Build Date.

Grayed CV’s indicate CV’s which are not supported by that model of locomotive. You can enable these CV’s in a
document by selecting “Enable All CV’s” in the Options menu.
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Creating a New Document
Click on the File menu “New…” command. The following dialog box will be displayed:

If your locomotive is QSI equipped, select  “Quantum Decoder” and select the class of locomotive, “Diesel”,
“Electric”, “Steam”, “Articulated Steam”, or “Gas Turbine”. Then select your locomotive’s model from the list for that
class.

If your locomotive is not QSI equipped, select “Other Decoder”.

Click on “OK” to create a new document.
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In Ops Mode you can have the new document’s Loco address automatically set to the working Decoder Address. For
example, if the working decoder address were “05600”, the dialog would show

If you leave the “Set document Extended Address to 5600” box checked, then when the new document is created,
CV17-18 will automatically be set to “5600” and CV29 bit 5 will automatically be set to “1”.

If the working Decoder Address were “025”, then the check box will read “Set document Primary Address to 25”. In
that case, when the new document is created, CV1 will automatically be set to “25”.

If you want the new document to have CV1 = “3”, CV17-18 = “0”, and CV29 to have CV29 bit 5 set to “0”, then uncheck
this box.

This box is disabled if the working Decoder Address is “003”.
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If you don’t know your decoder’s type and model, click on “About Decoder…”.

In Operations Mode, this dialog box is displayed:

If your locomotive is QSI equipped, pressing the “Read out” buttons will cause your locomotive to speak out the Model
Number, Soundset Number, Firmware Version Number, and Firmware Build Date. The decoder must respond to the
working Decoder Address shown at the left end of the main window Control Bar.

In Service Mode, this dialog is displayed:

Press the “Retrieve Decoder Info” button to have the blanks filled in by information retrieved from your locomotive.

When you close this dialog box, if your locomotive is QSI equipped and its model number is known by
QuantumCVManager, the appropriate model number is selected in the “New QuantumCVManager Document” dialog
box.

When you close this dialog box, the check box at the bottom of the “New QuantumCVManager Document” dialog box
is updated with the retrieved Decoder Address. The new document will be initialized to the retrieved Decoder Address
unless you uncheck the box. The box is disabled if the retrieved Decoder Address is short address 3.
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Changing Document CV Values
QuantumCVManager makes it easy to change CV values. You don’t have to type in the CV number and in most cases
you don’t have to type in the CV value. Instead you manipulate the following types of graphical controls.

Slider

Move the slider thumb to the right to increase the CV value, to the left to decrease the CV value. The decimal value of
the CV is displayed in the box to the left of the slider.

Check Box

Check boxes are used for CV’s where each bit independently controls a setting. Each check box represents one bit.
Click the left mouse button to check or uncheck a box. A checked box indicates the bit is “1”. An unchecked box
indicates the bit is “0”.

Radio Button

In a few cases a pair of radio buttons is used to represent a single bit. If the first button in a pair is selected the bit is
“0”. If the second button in a pair is selected, the bit is “1”.

List Box

The current selection is shown. Click on the down arrow button to display the other possible selections.
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“Change…” Button

In a few cases, you must click on a “Change…” button. A dialog box is displayed which requires you to type in the new
CV value.
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Changed CV Color Codes
The color of the CV number text, usually to the left of the CV value, indicates whether the decoder value of the CV is
known and, if it is known, whether it is different.

Red text indicates the value is different from the known decoder value.

Green text indicates the value is identical to the known decoder value.

Black text indicates the decoder value is not known.

In Operations Mode, the decoder’s value of a CV is known only when the CV is programmed to the decoder.

In Service Mode, the decoder’s value of a CV is known when the CV value is programmed to the decoder, or the CV
value is retrieved from the decoder, or the CV value is verified, i.e. compared to the decoder’s value.

Use the “Mark Decoder Value Unknown” command in the “Edit” menu to reset the state of a CV or group of CV’s to
“Decoder Value Unknown”.

In the above Operations Mode example, the value of CV3 is different from the value last programmed to the decoder.
The value of CV4 is identical to the last programmed value. The decoder values of CV23 and CV24 are not known
since these CV’s have not been programmed.
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Programming CV’s
You can program your locomotive’s CV’s one CV at a time, one page of CV’s at a time, several pages of CV’s at a
time, or all CV’s at once.

You select one of these ranges from the first four items of the Decoder menu. The first menu item is the name of the
active CV and the second menu item is the name of the active page.

In the above example, CV2 is the active CV. If you click on “Program”, your locomotive’s CV2 will be programmed with
the document’s CV2 value.

If you select “All ‘NMRA Motor’ CV’s” and then click on “Program”, your locomotive’s CV2, CV5, CV25, CV66, and
CV95 will be programmed with the document’s values for these CV’s. (The grayed CV’s are not programmed.)

If you select “Selected Pages” and then click on “Program”, a dialog box is displayed where you can select which
pages you want to program your locomotive with.

If you select “All CV’s”, all of the locomotive’s CV’s will be programmed with the document’s values.

The list box in the center of the control bar is a shortcut for the first four items in the Decoder menu. The three buttons
under the list box are shortcuts for the next three commands in the Decoder menu.
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An even faster shortcut is to use the right mouse button.  If you move the cursor over the rectangle highlighting the text
“CV2” and click the right mouse button, you will see a popup menu with the command “Program CV2”. If you move the
cursor over the “NMRA Motor Parameters” text and click the right mouse button, you will see a popup menu with the
command “Program All ‘NMRA Motor’ CV’s”. See the section on “Right Mouse Button” for more information.

In Ops Mode, if “Auto Program On” is selected, a change to any CV is automatically programmed in the locomotive. If
“Auto Program On” is enabled, the active CV number is highlighted with a red rectangle. Otherwise, the active CV
number is highlighted with a black rectangle.

Note: when you program a locomotive’s CV, you will not hear the locomotive acknowledge the new CV value verbally.
QuantumCVManager turns off Programming Verbal Acknowledgement by setting CV62 to “0”.
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Retrieving CV’s in Service Mode
In Service Mode, you can command QuantumCVManager to retrieve the values of your locomotive’s CV’s. The
locomotive’s values replace the document values.

You can retrieve CV’s one CV at a time, one page of CV’s at a time, several pages of CV’s at a time, or all CV’s at
once.

In the above example, if you click on the “Retrieve” button, the locomotive’s values for CV2, CV5, CV25, CV66, and
CV95 will be retrieved from the locomotive and be displayed in the various boxes.

A fast shortcut is to use the right mouse button.  If you move the cursor over the rectangle highlighting the text “CV2”
and click the right mouse button, you will see a popup menu with the command “Retrieve CV2”.

If you move the cursor over the “NMRA Motor Parameters” text and click the right mouse button, you will see a popup
menu with the command “Retrieve All ‘NMRA Motor’ CV’s”. See the section on “Right Mouse Button” for more
information.
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Verifying CV’s in Service Mode
In Service Mode, you can command QuantumCVManager to compare the values of the document’s CV’s with those of
your locomotive. If the document’s value differs from the locomotive’s you are given the choice to replace the
document’s value with the locomotive’s or vice versa.

You can verify CV’s one CV at a time, one page of CV’s at a time, several pages of CV’s at a time, or all CV’s at once.

In the above example, if you click on the “Verify” button, the locomotive’s values for CV2, CV5, CV25, CV66, and
CV95 will be retrieved from the locomotive and compared with the document’s values. Any differences will be noted in
a Verification Results dialog as shown below.

A fast shortcut is to use the right mouse button.  If you move the cursor over the rectangle highlighting the text “CV2”
and click the right mouse button, you will see a popup menu with the command “Verify CV2”.

If you move the cursor over the “NMRA Motor Parameters” text and click the right mouse button, you will see a popup
menu with the command “Verify All ‘NMRA Motor’ CV’s”. See the section on “Right Mouse Button” for more
information.
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In this example, the locomotive has different values for CV2 and CV66. Select one or more of the differences. You can
change the locomotive’s value(s) to the document’s value(s) by clicking on “Doc  Decoder”. You can change the
document’s value(s) to the locomotive’s value(s) by clicking on “Doc  Decoder”.
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Reset Document to Defaults
To reset a document’s CV’s to default values, click on the Edit menu “Reset to Defaults…” command. The following
dialog box will be displayed.

The first range choice is the name of the active CV. The second range choice is the name of the active page. Select
the range of CV’s you want to reset and click on “OK”.

A fast shortcut is to use the right mouse button.   If you move the cursor over the rectangle highlighting the text “CV2”
and click the right mouse button, if the CV2 value is not the default value, you will see a popup menu with the
command “Reset CV2 to default value <value>”.

If you move the cursor over the “NMRA Motor Parameters” text and click the right mouse button, if any of the CV
values on this page has a non-default value, you will see a popup menu with the command “Reset all ‘NMRA Motor’
CV’s to default values”. See the section on “Right Mouse Button” for more information.
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Reset Decoder to Defaults
To reset a QSI equipped locomotive’s CV’s to factory default values, press the control bar “Reset Decoder…” button.
This is a shortcut for the Decoder menu “Reset Decoder to Defaults…” command.

The following dialog box is displayed:

Select the range of CV’s you want to have reset, and click the “OK” button.

Note: in Service Mode, using the NCE Powerhouse, reset “All CV’s” may not work correctly because the NCE shuts off
the track power too soon for all of the CV’s to be reset. You may have to do several reset operations, each operation a
reset of a smaller range of CV’s.
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Right Mouse Button
Move the cursor over a CV’s text label and click the right mouse button to display a popup menu.

Several commands are displayed which are shortcuts to menu bar or control bar commands.

At the bottom of the menu, the CV value is displayed as a decimal and hexadecimal number. For bit oriented CV’s it is
also displayed as a binary number.
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For most CV’s an additional “Edit CV…” command is displayed. If you click on this command, the following dialog box
is displayed:

Here you can type in a CV value as a decimal, hexadecimal, or binary number.
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If you move the cursor to the top of the page over the text description of the page and press the right mouse button, a
popup menu with commands applicable to all the CV’s on that page is displayed.
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About Quantum Decoder
The “About” tabbed page contains information about your QSI equipped locomotive. This information is very useful
when reporting problems to QSI about your locomotive’s misbehavior.

In Ops Mode, you can have the locomotive speak out these numbers. Move the cursor over the label for an item and
press the right mouse button. A popup menu will display the command “Verbally read out …”. Move the cursor to this
command and press the left mouse button. You can also use the control bar “Read Out” button.

In Service Mode, these numbers can be retrieved from the locomotive to be displayed in the boxes.  Move the cursor
over the label for an item and press the right mouse button. A popup menu will display the command “Retrieve …”.
Move the cursor to this command and press the left mouse button. You can also use the control bar “Retrieve” button.
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Program Any CV
The “Program Any CV” dialog provides a way to program a CV which is not part of a Quantum CV Manager document.

To explicitly program any CV click on the control bar “Program Any CV…” button. This is a shortcut for the Decoder
menu “Program Any CV…” command.

The following dialog is displayed:

Type in the CV number, optional Primary Index (PI), optional Secondary Index (SI) and CV Value. All numbers must be
decimal. Then press “Program”.

Here is an example of how you would program a standard NMRA CV which does not require a Primary or Secondary
Index. Just leave the PI and SI entries blank.

Here is an example of how you would program a CV using a Primary Index. Leave the SI entry blank.
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Here is an example of how you would program a CV using both a Primary Index and a Secondary Index.

In Operations Mode, QSI equipped locomotives can speak out the value of any CV. To hear what the current value of a
CV is, press the “Read out” button instead of the “Program” button. In the above example, pressing “Read out” would
cause a QSI equipped locomotive to speak out its current value of CV53.14.1.

In Service Mode, the “Read out” button is replaced with the “Retrieve” button. Pressing this button causes the
locomotive’s current value of the specified CV to be retrieved from the locomotive and displayed in the “Value” box.

In the above example, pressing “Retrieve” would display the locomotive’s current CV2 value in the “Value” box.

QuantumCVManager uses the “PI” and “SI” entries to program CV49 and CV50. Thus, using PI and SI with non QSI
equipped locomotives won’t work.
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Decoder Address
The working Decoder Address is displayed at the left end of the control bar. The working address is used in Operations
Mode to specify the decoder you want to program.

Short addresses are displayed as 3 digit numbers padded with leading zeros if necessary. For example, “003” means
short address 3.

Long addresses are displayed as 5 digit numbers padded with leading zeros if necessary. For example, “00003”
means long address 3.

To change the working Decoder Address, press the control bar “Decoder Address…” button just above the box
displaying the working Decoder Address. This button is a shortcut for the Decoder menu “Decoder Address…”
command.

The following dialog box is displayed:

Type in the decoder address and select “Short Address” or “Long Address”.

Valid short addresses are 1…127.

Valid long addresses are 0…10239.

If you want the document Primary or Extended address set to the new working Decoder Address, leave the checkbox
checked as shown.
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The working Decoder Address may be different from the Primary Address (CV1) and the Extended Address (CV17 and
CV18) as in the following example:

When you program the NMRA Loco Parameters CV’s in Operations Mode, this dialog box is displayed:

QuantumCVManager detects the conflict between the working Decoder Address and the about to be programmed
locomotive Extended Address. It proposes to use the working short address of “3” to program CV17, CV18, and CV29
and then change the working Decoder Address to Long Address “5123”.
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This is the result of clicking on “OK”:

Here the working Decoder Address has been automatically changed to “05123” to match the locomotive’s new CV17,
CV18, and CV29 values.
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Non QSI Equipped Locomotives
If you create a document for a locomotive that is not QSI equipped, then the document window is somewhat changed:

The main difference is in the Manufacturer Unique CV’s 47-64. A single tabbed page is provided. You can either type
CV values into the edit box to the right of each CV text label or you can use the right mouse button to display a popup
menu with the “Edit CV…” command. Auto Program does not apply to CV’s 49-64 for non QSI decoders.

In the Motor tabbed page, the CV25 list box is replaced with an Edit Box. Auto Program does not apply to changes to
CV25.

A few commands are disabled. These include

Decoder Menu:
Reset Decoder to Defaults…
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Test Cabs
In Operations Mode, Test Cabs can be used to operate a locomotive.

There are two types of Test Cabs: attached and unattached.

 A Test Cab is attached to each document and is displayed when the document is created or opened. An attached Test
Cab follows changes made to its document.

Unattached Test Cabs do not follow changes made to a document. There are 4 unattached Test Cabs, numbered 1, 2,
3 and 4.

To show Test Cab #1, click on the View menu item “Show Test Cab #1”. To hide the Test Cab #1 either close it by
clicking on the “X” button in the upper right corner, or click on the View menu item “Hide Test Cab #1”.

If a Test Cab is visible and you switch to Service Mode, the Test Cab will be hidden until you return to Operations
Mode.

Loco

At the top of the Test Cab, you select the address of the locomotive you wish to operate from the list provided. The
default address is short address 3.
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Test Cabs attached to a document follow changes made to the working Decoder Address which is displayed at the left
end of the control bar.

For unattached Test Cabs, the Test Cab loco address is independent from the QuantumCVManager working Decoder
Address.

Short addresses are displayed as 3 digit numbers, padded with leading zeros if necessary. For example, “003” means
short address 3.

Long addresses are displayed as 5 digit numbers, padded with leading zeros if necessary. For example, “00003”
means long address 3.

You can add additional addresses to the list by pressing “Add…” causing a dialog box to appear where you can enter
the new address.

You can remove unwanted addresses from the list by selecting the address you want to remove and pressing “Del”.

Speed

To increase your locomotive’s speed, move the throttle slide bar to the right. The speed step minus 1 is shown in the
box to the immediate right of “Speed”. You can select between 14, 28 and 128 speed steps from the list box.

Press one of the four buttons just below the throttle slide bar to decrease or increase the speed by the shown fixed
amount.

Switch direction by clicking on the “Forward” or “Reverse” buttons.

“Emergency Stop” brings your locomotive to an immediate stop.

Function Keys

F0…F12 are supported.

When a function key state is 1 (ON), the button is highlighted with red.

FL is the same as F0.

The “Bell” button is an alternative to “F1”. Bell and F1 provide the same functionality. When either Bell or F1 is pressed
ON, the bell plays. When either is pressed again to OFF, the bell stops playing.

The “Horn” button is an alternative to F2. “Horn” and “F2” provide the same functionality, but work differently. When the
Horn button is held down, the horn plays.  When you release the Horn button, the horn stops. When you press F2, the
function key turns ON and horn plays, and continues to play when you release the F2 button. You must press F2 again
to turn the horn oOFF.

When you move the cursor over a Function Key of a Test Cab attached to a document, a balloon help message is
displayed describing the feature controlled by that function key. The feature is determined from CV33 thru CV46
settings and CV53 settings.  If CV33-46 specifies more than one output, only the lowest numbered output is used.
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Disable Main Track

This is a quick way to turn off power to the main track. It is a shortcut for the “Command Station | Disable Main
Track” menu item.

Power to the main track is turned on automatically when you press any function key or move the throttle.
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User Defined Speed Table
The NMRA User Defined Speed Table, CVs 64-97, is specified in the “Spd Tbl” tabbed page.

To change one of these CV values, move the cursor over the corresponding square drag box, press the left mouse
button, and drag the box up to increase the CV value, or down to decrease the CV value.

The active CV drag box is highlighted in yellow or blue. The value of the active CV is displayed in yellow or blue at the
upper left of its drag box. The active CV number at the bottom of the graph is outlined in black or red.

When the active CV drag box is yellow and the CV value is highlighted in yellow, the CV has the keyboard focus, and
you can use the keypad to increase or decrease the CV value. The up arrow increases the CV value, and the down
arrow decreases the CV value.

If “Auto Program On” is selected, the active CV number is outlined in red. Beware that when “Auto Program On” is
selected, more than one CV may be programmed when you move the drag box for a CV, requiring several seconds to
program the entire range of affected CV’s. The range of CV’s affected depends on the control mode (see below).



QuantumCVManager User Manual Ver 1.1.2 Page 42 of 53 21-July-08

If you move the cursor over a CV drag box or a CV number at the bottom of the graph and press the right mouse
button, a popup menu is displayed. For example,

If you move the cursor over the “NMRA Speed Table” text and press the right mouse button, a popup menu pertaining
to all theSpeed Table CV’s is displayed.

Control Modes

Several Control Modes are provided. The default “Non-Decreasing” mode makes sure that each CV to the right of the
active CV has a value equal to or greater than the value of the active CV, and each CV to the left of the active CV has
a value equal to or less than the value of the active CV.

If you do not want this restriction enforced, select the “Unrestricted” control mode.

Several linear modes are provided. You can use 2, 3, 4, or 5 control points. Only the control points can be changed by
dragging the CV drag box up or down. The values of the CVs between the control points are restricted to lie on a
straight line between the two control points. CV 67 and CV97 are always two of the control points. For the 3, 4, or 5
control point modes, you can select which CV is a control point by dragging the dotted vertical line to the left or right.

Using the “Exponential” mode, you can drag any of the CV drag boxes up or down. The remaining CV values are also
increased or decreased to lie on the exponential curve passing through the CV you just dragged. If the “Show Guide
Curves” is checked, graphs of ten exponential curves are displayed. The guide curves correspond to the ten
predefined speed curves that you can select in CV25.

Ops Mode Programming Assist
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QuantumCVManager makes it easy to match a Quantum equipped locomotive’s speed profile to that of a “standard”
locomotive. QuantumCVManager can show you what CV’s to adjust to match the speed of the standard locomotive at
any speed step.

Any changes to the attached Test Cab throttle are followed in the “Spd Tbl” page. QuantumCVManager determines
that at speed step 40, CV75 and CV76 are used by the locomotive to determine the percentage of power to be applied
to the motor. It shows the value of each CV and the interpolated value since speed step 40 corresponds to a point
between CV75 and CV76 on the speed curve. The actual power applied to the motor after Vstart (CV2), Vhigh (CV5)
and Forward or Reverse Trim (CV66 or CV95) are applied is shown.

You can verify that this is the power applied to the motor via the status report. If the PWM box is checked in
CV55.178.0, pressing F10 on the Test Cab will cause the locomotive to speak out the PWM value being applied to the
motor.

There are several things that can go wrong in this process. QuantumCVManager can detect the four main reasons and
display warning messages as shown outlined in red in the above example:

Cab Address != Decoder Address
CV29 bit 4 is “0”
CV25 != ‘0’ or “1”
CV56.4 != “0”
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First, the Test Cab address does not match the working Decoder Address. If you program any CV’s, the commands
are addressed to locomotive “003”. But the Test Cab #1 commands are addressed to locomotive “004”. Change one or
both addresses so that both sets of commands are addressed to the same locomotive.

Second, CV29 bit 4 must be “1” to enable speed tables to be used. Go to the “Loco” tabbed page and select “Speed
Table Set by CV25”. Remember to program CV29.

Third, CV25 must be “0” or “1”.  Go to the “Motor” tabbed page and select “0 User Defined Speed Table (CV67-CV94)”.
If “Auto Program On” is not selected, remember to program CV25.

Fourth, CV56.4 should be “0” for “Standard Throttle Control”. Only in this throttle mode are you guaranteed that the
PWM calculated from the speed table is the value actually applied to the motor. In the other throttle modes, even if
speed tables are used, the actual PWM is determined from the PID control loop in order to match a certain speed. Go
to the “Config” tabbed page and select “Standard Throttle Control” for CV56.4.

When you correct these conditions, the corresponding warnings disappear from the “Spd Tbl” page.
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Command Station
QuantumCVManager currently supports only two types of command stations:

NCE Powerhouse
Quantum Programmer

Select the command station you want to use via the “Command Station | Select Command Station” menu item.

The command station currently in use is displayed in the lower right corner of the status bar.

The default command station is “Quantum Programmer”.

Note: When you exit QuantumCVManager, power to the main track is not automatically turned off. Use the “Disable
Main Track” command before you exit.

NCE Powerhouse
The NCE Powerhouse uses RS232. If this command station is selected, you can select the Comm Port and Baud Rate
to be used via the “Command Station | Command Station Options | NCE Powerhouse Options…” menu item.

QuantumCVManager works with the NCE Powerhouse in both Operations Mode and Service Mode.

QSI equipped locomotives work well with the NCE Powerhouse in Operations Mode. For reliable Service Mode
programming, a simple, inexpensive power booster may be required. This booster, PowerPak™ by DCC Specialties,
can be purchased from Tony’s Train Exchange®.

Quantum Programmer
The Quantum Programmer uses USB. Two different USB drivers are supported: the standard SiLabs USB driver and
the SiLabs Virtual Comm Port driver.

Use the “Command Station | Command Station Options | Quantum Programmer Options…” menu item to select
the driver and to specify the Comm Port  if the VCP driver is to be used.

QuantumCVManager works with the Quantum Programmer in both Operations Mode and Service Mode. Operations
Mode support is limited. Currently only one locomotive can be controlled at a time. Possibly you could control more
than one locomotive with the same address or a single advanced consist, but due to the limited power output of the
Quantum Programmer, this is not advised.

The Quantum Programmer was specifically designed to work with QSI equipped locomotives. Although it uses
standard NMRA DCC protocols, very limited testing has been performed with other manufacturer’s decoders. QSI
makes no claims as to whether the Quantum Programmer can or cannot be used with other manufacturer’s decoders.
Use other manufacturer’s decoders with Quantum Programmer at your own risk.
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Printing
Use the “File | Print...” command to print the active document.

Use the “File | Print Preview” command to display on the screen what the printed document will look like. Depending
on the font used, the text on the preview screen image may not look exactly correct. This is due to the way the system
approximates the printer font as it is rendered on the video screen.

Use the “File | Print Setup...” command to select the printer and choose among options the printer supports.

The “File | Page Setup...” command displays the Page Setup dialog.

The printed content always includes the CV number and the CV value. In the “Content” group, select which additional
columns of information you want printed. Select also whether you want the CV’s organized by category or printed out in
order of CV number.

Use the “Font…” button to select from the available printer fonts.

In the “Margins” group, specify how far from each edge of the page the text should begin and end. You can use inches
or centimeters.

In the “Header” and “Footer” groups, type in the text to be printed at the top and bottom of each page. You can type in
special format fields which are filled in automatically as each page is printed. The available format fields are shown to
the right of the Header and Footer groups in the dialog box above. Each format field starts with a ‘%’. You can mix
format fields with regular text as shown the Center Footer box above. If you want the regular text to include a ‘%’, type
“%%”.
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Using the above Header specifications would result in a header looking something like this:

Using the above Footer specifications would result in a footer looking something like this:
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QCV Files
QuantumCVManager documents are saved as QCV files. These files are text files which are displayable by any text
editor. Here is an example of a QCV file:

DecoderType=0
QuantumModel=100
CV1=3
CV2=28
CV3=0
CV4=0
CV5=1
CV6=0
CV7=0
CV8=113
CV9=0
CV10=0
CV11=1
CV12=0
CV13=0
CV14=0
CV15=0
CV16=0
CV17=212
CV18=3
CV19=0
CV20=0
CV21=0
CV22=0
CV23=0
CV24=0
CV25=2
CV26=0
CV27=0
CV28=0
CV29=38
CV30=0
CV31=0
CV32=0
CV33=3
CV34=3
CV35=4
CV36=8
CV37=16
CV38=4
CV39=8
CV40=16
CV41=32
CV42=64
CV43=16
CV44=32
CV45=64
CV46=128
CV47=0
CV48=0
CV51.0=109
CV51.1=0
CV51.2=1
CV52.0=11
CV52.8=11
CV52.10=11
CV52.13=11
CV52.14=11
CV52.15=11
CV52.16=11
CV52.19=11
CV52.21=11
CV52.22=11
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CV52.24=11
CV52.28=11
CV52.34=11
CV52.37=11
CV52.40=11
CV53.1.0=136
CV53.1.1=136
CV53.2.0=136
CV53.2.1=136
CV53.3.0=3
CV53.3.1=3
CV53.4.0=1
CV53.4.1=1
CV53.5.0=211
CV53.5.1=211
CV53.6.0=8
CV53.6.1=8
CV53.7.0=5
CV53.7.1=5
CV53.8.0=65
CV53.8.1=144
CV53.9.0=216
CV53.9.1=9
CV53.10.0=64
CV53.10.1=64
CV53.11.0=179
CV53.11.1=145
CV53.12.0=178
CV53.12.1=178
CV53.13.0=137
CV53.13.1=137
CV53.14.0=138
CV53.14.1=138
CV55.3.0=2
CV55.3.1=1
CV55.70.0=1
CV55.70.1=86
CV55.70.10=192
CV55.73.0=1
CV55.73.1=101
CV55.73.10=192
CV55.76.0=1
CV55.76.1=3
CV55.76.2=1
CV55.76.3=1
CV55.76.4=1
CV55.76.10=32
CV55.80.0=1
CV55.80.1=1
CV55.80.2=1
CV55.80.3=3
CV55.80.4=1
CV55.80.10=192
CV55.84.0=1
CV55.84.1=6
CV55.84.2=0
CV55.84.3=0
CV55.84.4=0
CV55.84.5=5
CV55.100.0=1
CV55.100.1=85
CV55.102.0=1
CV55.102.1=85
CV55.104.0=1
CV55.104.1=85
CV55.106.0=1
CV55.106.1=85
CV55.112.0=1
CV55.112.1=85
CV55.114.0=1
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CV55.114.1=85
CV55.116.0=1
CV55.116.1=68
CV55.118.0=1
CV55.118.1=68
CV55.136.0=255
CV55.136.1=0
CV55.136.2=0
CV55.137.0=0
CV55.137.1=255
CV55.137.2=0
CV55.138.0=0
CV55.138.1=0
CV55.138.2=255
CV55.178.0=1
CV56.0=0
CV56.4=1
CV56.5=2
CV56.10=64
CV56.12=32
CV56.18.0=20
CV56.18.1=2
CV56.18.2=60
CV56.19.0=16
CV56.19.1=2
CV56.19.2=16
CV56.20.0=10
CV56.20.1=2
CV56.20.2=10
CV56.21.0=7
CV56.21.1=2
CV56.21.2=2
CV65=0
CV66=146
CV67=0
CV68=9
CV69=18
CV70=28
CV71=37
CV72=47
CV73=56
CV74=66
CV75=75
CV76=85
CV77=94
CV78=103
CV79=113
CV80=122
CV81=132
CV82=141
CV83=151
CV84=160
CV85=170
CV86=179
CV87=188
CV88=198
CV89=207
CV90=217
CV91=226
CV92=236
CV76=245
CV94=255
CV95=128
CV96=0
CV97=0
CV98=0
CV99=0
CV100=0
CV101=0
CV102=0
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CV103=0
CV104=0
CV105=0
CV106=0



QuantumCVManager User Manual Ver 1.1.2 Page 52 of 53 21-July-08

Trouble Shooting
Reset All CV’s does not work in Service Mode
In Service Mode, using the NCE Powerhouse, reset “All CV’s” may not work correctly because the NCE shuts off the
track power too soon for all of the CV’s to be reset. You may have to do several reset operations, each operation a
reset of a smaller range of CV’s.

First Ops Mode Program or Read out does not work
In Ops Mode you may find you have to repeat the first request to program or read out a locomotive’s CV. The first
attempt merely turns the locomotive’s sounds on but the program or read out request is discarded during Ops Mode
initialization. On the second attempt, the locomotive programs the CV or speaks out the CV value. In general in Ops
Mode make sure the locomotive is in Ops Mode, indicated by its making sounds, before attempting to program or read
out a CV.

Retrieve, Verify or Read out does not work
You may find that you can apparently program a CV, but you cannot Retrieve, Verify or have the locomotive Read out
the CV value. If that is the case, then probably that CV is not supported by the locomotive. For example, if you attempt
to verify CV6, you will get a “NA” indication. If you attempt to read out CV6, the locomotive will announce only “C V 6”.
If CV6 were supported by the locomotive, and the value of CV6 were “128”, for example, the locomotive would
announce “C V 6 equals one two eight”.
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